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EC Declaration of Conformity

This product conforms (or these products conform) to the provisions of Council Directive 89/336/EEC and 73/23/
EEC. The Declaration of Conformity is available at Nortel Networks, 4100 Guardian Street Simi Valley, CA 93065 
attention: Regulatory Department.

LIMITATIONS OF REMEDIES

Nortel’s entire liability and Customer’s exclusive remedies are as follows: Nortel shall (i) use commercially 
reasonable efforts to correct any failure of the software program, of which it is given written notice by Customer 
during the Warranty Period, to perform substantially in accordance with the documentation, provided such failure 
can be recreated by Nortel in an unmodified version of the software program, or if Nortel is unable to correct such 
failure the software program and documentation may be returned and the license fee paid will be refunded, or (ii) 
replace any diskette not meeting Nortel’s “Limited Warranty” or, if Nortel is unable to deliver a replacement 
diskette which is free from defects in materials or workmanship, the software program and documentation may be 
returned and the license fee paid will be refunded. 

IN NO EVENT WILL NORTEL OR ITS SUPPLIERS BE LIABLE TO CUSTOMER FOR ANY LOST 
PROFILES, LOST SAVINGS OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT 
OF THE USE OR INABILITY TO USE THE PROGRAM EVEN IF NORTEL HAS BEEN ADVISED OF THE 
POSSIBLITY OF SUCH DAMAGES. THE LIABILITY OF NORTEL, IF ANY, FOR DAMAGES RELATING 
TO ANY NORTEL SOFTWARE PRODUCT SHALL BE LIMITED TO THE ACTUAL AMOUNTS PAID BY 
CUSTOMER FOR SUCH SOFTWARE PRODUCT.

SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR THE LIMITATION 
OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE 
EXCLUSIONS OR LIMITATION MAY NOT APPLY.
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Safety Warnings and Cautions

Various safety agencies request statements of warning or caution to help you in the safe operation of the unit.  
These statements also apply to any and all modules installed within the unit.

To ensure adequate cooling of the 
equipment a 2.0 inch unobstructed 
space must be maintained around all 
sides of the unit.

Um die Kühlung des Gerätes nicht zu 
beschränken, ist es notwendig um das 
Gerät herum an allen Seiten ca 5 cm 
Raum zu lassen.

Pour assurer un refroidissement 
adéquat, maintenir un espace libre de 
5 cm (2 pouces) tout autour de 
l’appareil.

The ac power socket shall be installed 
near the equipment and shall be easily 
accessible.

Stellen Sie das Gerät in der Nähe einer 
geerdeten Schutzkontakt- steckdose 
so auf, dass diese leicht erreichbar und 
zugänglich ist.

Installer la prise AC à proximité de 
l’appareil, dans un rayon d’accès 
facile.

Installation and access to the interior 
of this unit shall be made only by a 
qualified technician.

Die Montage und der Zugang ins 
Innere des Gerätes sind nur einem 
qualifizierten Techniker gestattet.

L’installation et l’ouverture de cet 
appareil est permise par un technicien 
autorisé seulement.

Connection to the network is to be 
disconnected before the (mains) plug 
is removed.

Ehe der Netzstecker aus der Steckdose 
gezogen wird, müssen sämtliche 
äusserliche Verbindungen vom Gerät 
getrennt werden.

Avant de débrancher la prise de 
courant, assurer que toutes les 
connexions externes ont été 
déconnecté de l’appareil.

Warning Warnung Avertissement

Remove power plug from the power 
socket before performing any service 
work on the unit.

Vor öffnen des Gerätes, muss der 
Netzstecker aus der Steckdose 
gezogen werden.

Débrancher la prise de courant avant 
d’entreprendre aucun travail de 
réparation de l’appareil.

The power supply is auto-ranging in 
this model.

Netzteil ist mit automatischer  
Umschaltung entsprechend der 
Versorgungsspannung versorgt.

Ce modèle s’adapte automatique- 
ment au courant électrique ou voltage 
de la prise murale.

The power supply cordset to be 
supplied in Europe must have 
0.752mm, 3 conductor “HAR” cord 
type H05VV-F, terminated in a 
grounding type Shucko plug on one 
end and a molded-on IEC 320 
connector on the other end.

Die Netzleitung sollte ein 
harmonisierter Typ (HAR) sein, mit 
der Bezeichnung H05VV-F oder 
H05VVH2-F, 3G 0.752mm, mit einem 
Schutzkontakt - und einem 
Kaltgerätestecker (IEC 320).

En Europe, brancher l’appareil à la 
prise murale au moyen d’un fil 
“HAR” comprenant 3 cables 
H05VV-F ou H05VVH2-F de 
0.752mm chacun, avec à une extremité 
une prise de terre genre SHUCKO et à 
l’autre une prise IEC 320. 

Technical Data Technische Daten Donnees Techniques

Passport 4400 Series
ac units
Input Voltage 100-240 Vac

-5%,  +10%
Input Current: 3A/1.5A
Frequency: 47-63 Hz
dc units
Input Voltage 36-72 Vdc
Input Current: 5A

Passport 4400 Series
ac Geraete
Nennspannung: 100-240 V∼

-5%, +10%
Nennstrom:  3A/1.5A
Frequenz: 47-63 Hz
dc Geraete
Nennspannung: 36-72  V
Nennstrom: 5A

Passport 4400 Series
ac appareils
Voltage d’Accès: 100-240 V∼ 

-5%, +10%
Courant d’Accès: 3A/1.5A 
Fréquence: 47-63 Hz
dc appareils
Voltage d’Accès: 36-72 V
Courant d’Accès: 5A
209664-A
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Notification of FCC Requirements

NOTE:  This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause 
harmful interference in which case the user will be required to correct the interference at his own expense.

Changes or modifications to this product, that could increase the amount of Radio Frequency Emissions from this 
product, without the expressed written approval of Nortel Networks could cause the product and the user to violate 
the FCC’s Rules and Regulations, thus requiring the product to be turned off or disconnected.

If this unit is used on a DTE which requires use of shielded cables for compliance with FCC Part 15, then use of a 
filtered pin connector may be required to maintain FCC compliance. See the Installation section for specific 
applications.

Notification of Canadian Requirements

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus as set out 
in the Radio Interference Regulations of the Government of Canada Department of Industry.

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils 
numériques de classe A prescrites dans le règlement sur le brouillage radioélectrique édicté par le Ministère des 
Industry du Canada.
Getting Started with Passport 4400, Release 4.1
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Chapter 1
Introduction

This manual is specific to the Passport 4460 unit. Many references are made to the 
Passport 4400 unit, which is a generic term for all Passport 4400 units. In this 
manual, the terms Passport 4460 and Passport 4400 are interchangeable.

Topics in this manual:

• Chapter 1, “Introduction”

• Chapter 2, “Online Documentation”

• Chapter 3, “Hardware Setup”

• Chapter 4, “Configurator Procedure for Creating a Node Profile”

• Chapter 5, “Accessing the CLI and Basic Configuration”

• Chapter 6, “CLI Procedure for Creating a Node Profile”

• Appendix A, “IfIndexes and Interface Identification”

• Appendix B, “Installing System Software from the CD-ROM"

Topics in this chapter:

• “List of Documentation” on page 12

• “Unpacking the Unit” on page 12

• “Determining Which Management Tool to Use” on page 14
Getting Started with Passport 4400, Release 4.1
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List of Documentation

The following documentation will assist you in the installation and operation of 
your Passport 4460 unit:

• Getting Started with Passport 4400, Rel. 4.1 Software, 209664-A (this 
document)

• Using Passport 4400 Install Tool Version 4.1, 206906-B (provided in hard 
copy in the Passport software kit)

• Configuring and Operation Passport 4400 Rel. 4 Software, 206916-A 
(provided on CD-ROM or on the web). This is software documentation for the 
system describing configuration/provisioning using the Passport 4400 
Configurator and CLI.

• Reference for Passport 4460 Hardware, 205677-A

• Reference for Passport 4400 Cables, 205678-A

• Reference for Passport 4400, 6400 Interworking, 209372-A

• Getting Started with Passport 4400 and 6400 Interworking, 209371-A

• Passport 4400 Release Notes, 209373-A

• Reference for Passport 4400 Command Line Interface (CLI), 209666-A

• Using the Passport 4400 Mass Deployment and Reporting Tool, 209665-A

Unpacking the Unit

The first thing to do is to unpack your unit and check the contents of your Passport 
unit. Make sure you have received the following items:

• Setup Poster

• Base Unit

• Modules ordered - installed (these will vary according to the requirements of 
your network)

• Documentation

— Reference for Passport 4460 Hardware, 205677-A

— Reference for Passport 4400 Cables, 205678-A
209664-A
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• Cables

— Management port cable to DTE (DB-9 female to DB-9 female) 15 ft., 
207490-A

— Crossover LAN cable RJ-48C to RJ-48C, 207232-A

— Any cables that belong to the modules being used

• Accessory kit:

— rackmount ears (2)

— flat-head screws (4)

— rubber feet (4)

• Two WAN faceplates (may be installed on unit depending on the modules 
ordered)

• Two Expansion faceplates (may be installed on unit depending on the 
modules ordered)

• Power cord

The PCMCIA Flash card is ordered separately and is packaged with the Software 
accessory kit, which includes the following:

• Getting Started with Passport 4400, Release 4.1, 209664-A, (this document)

• Software and Documentation CD ROM (Configuring and Operation Passport 
4400 Rel. 4 Software, 206916-A)

• Using Passport 4400 Install Tool Version 4.1, 206906-B

• Passport 4400 Release 4.1 Release Notes, 209373-A

• Passport software license
Getting Started with Passport 4400, Release 4.1
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Determining Which Management Tool to Use

The Passport 4460 unit is managed through Simple Network Management 
Protocol (SNMP), which is an application-level protocol that operates over TCP/
IP. Therefore, all of the Passport 4460 device management tools accept your 
commands and instructions, then translate them into SNMP commands. 

Device Management Tools

Configuring a Passport 4460 typically involves the use of Passport 4460 and one 
or more of the following device management tools:

• Install Tool

• Passport 4400 Configurator

• Command Line Interface (CLI)

• Mass Deployment and Reporting Tool (MDT)

Note: Refer to Using Passport 4400 Install Tool Version 4.1, 206906-B 
Chapter 1, for more information to help you determine which 
management tool to use.
209664-A
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This chart will help you decide which device management tool is best suited for 
your needs.

Tool
Workstation 
you will 
need:

When To Use It
For More 
Information

Install Tool Windows-
based PC

Use Install Tool to set up a 
factory-new or factory-defaulted 
Passport 4460 unit, such that 
network connectivity and basic 
services are enabled. In addition, 
you can use Install Tool to perform 
real-time monitoring of Passport 
4400 units in your network.

Refer to the Using 
Passport 4400 Install 
Tool Version 4.1, 
206906-B.

Passport 4400 
Configurator

Any 
workstation 
that supports 
a browser 
(Internet 
Explorer or 
Netscape)

Use the Configurator to perform 
any Passport 4460 configuration 
task. 
Note 1: The Passport 4400 
Configurator is an embedded web 
interface. It is a built-in component 
of Passport 4460 units.

Note 2: To access the Passport 
4400 Configurator from within 
Install Tool, select Web 
Configurator from the System 
menu.
Note 3: Like Install Tool, the 
Passport 4400 Configurator can 
access the Passport 4460 unit 
through PPP IP connectivity.

Refer to the 
Configuring and 
Operating 
Passport 4400 
Software, 206916-A 
(online 
documentation).

Command Line 
Interface (CLI)

Dumb 
terminal or 
terminal 
emulation 
software

Use the CLI to perform any 
configuration task, especially 
low-level or specialized tasks. 

Refer to the 
Passport 4400 
Reference for CLI, 
209666-A.

Mass 
Deployment 
and Reporting 
Tool (MDT)

Windows-
based PC

Use the Mass Deployment and 
Reporting Tool to generate 
configuration reports and to 
replicate the configuration of one 
unit to multiple units.

Refer to the Using 
the Passport 4400 
Mass Deployment 
and Reporting Tool, 
209665-A 
Getting Started with Passport 4400, Release 4.1
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Network Management Tools

The following network managements are compatible with Passport 4460 units:

• Optivity NMS 9.0

Offers a powerful set of tools for automating the management of diverse, 
multivendor networks. With Optivity NMS 9.0, you can control activity on an 
enterprise network (a network of heterogeneous Ethernet, Fast Ethernet, 
Token Ring, FDDI, and Frame Relay internetworks that consist of high-speed 
backbones, geographically dispersed networks, local wiring closet hubs, 
routers, servers, end-user workstations, and a variety of cabling media) all 
from a single management station.

• Preside Multiservice Data Manager (PMDM)

A network management platform used in heterogeneous networks as a 
method of standardization of information processing. Used in large networks, 
PMDM is highly scalable and offers many tools. Surveillance of all the 
devices is done using the same set of tools and presents results consistently 
across devices.

• Open Management System for Passport (OMS-P, Version 4.1)

A SNMP-based network management platform that builds on a third party 
product (HP OpenView) and adds device integration into that product. Used 
in large networks of heterogeneous SNMP devices and provides a common 
representation of different devices and their management information.
209664-A
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This chart will help you decide which network management tool is best suited for 
your needs.

Tool
Workstation 
you will need:

When To Use It
For More 
Information

Optivity NMS 
9.0.1

See footnote 1 Use Optivity NMS 9.0.1 when 
automating the management of 
diverse, multivendor networks. 

See footnote 1

Preside 
Multiservice 
Data Manager 
(PMDM)

See footnote 2 Use PMDM in heterogenous 
networks to provide consistency 
across devices.

See footnote 2

Open 
Management 
System for 
Passport 
(OMS-P, 
Version 4.1)

See footnote 3 Use OMS-P when building on a 
third party product and adding 
device integration into the product.

See footnote 3

1. Optivity NMS 9.0.1 URL: Http://www.nortelnetworks.com/products/02/datasheets/
3080.html
2. PMDM URL: http://www.nortelnetworks.com/products/01/preside/
3. OMS-P URL: http://google.netscape.com/
netscape?query=open+management+system+for+passport
Getting Started with Passport 4400, Release 4.1
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Chapter 2
Online Documentation

Topics in this chapter:

• “Accessing the Online Documentation” on page 19

• “Navigating Online Documentation” on page 21

• “Printing Online Documentation” on page 25

• “Browsers” on page 25

The online documentation (Configuring and Operating Passport 4400 Rel. 4 
Software, 206916-A) provides comprehensive information for configuring and 
operating your Passport 4460 unit. The documentation resides on the CD-ROM in 
your software accessory kit. 

Accessing the Online Documentation

To access the documentation on the CD-ROM:

1 Place the CD into the drive

2 From the D: drive (assuming D: is your CD-ROM drive) icon on your screen 
double click on the CD icon

3 Double click on the docs icon

For a particular manual in PDF format (you will need Acrobat Reader), 
double click on the file you want or you can continue with step 4. 

4 Double click on the config_ops_doc icon

5 Double click on the index.html icon

You should now have access to Passport 4400 Release 4 Configuration and 
Operation Documentation on the web.
Getting Started with Passport 4400, Release 4.1
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For installing documentation from the CD-ROM

After doing the steps 1, 2, and 3 above, you can install documentation by 
following the procedures in the following icons:

• If you are using Windows, ouble click on config_ops_doc.exe and follow the 
directions

• If you have a UNIX workstation you extract the documentation by doing a 
double click on config_ops_doc.tar and follow the directions

This documentation is also available for downloading from the web 
page

From the Internet, you can access the documentation from this URL:

http://support.baynetworks.com/library/tpubs/passport/v41/index.html

Open the documentation

• If you are using the Passport 4400 Configurator, click on the Documentation 
link in the navigation menu. The online documentation will display in a new 
browser window. Ensure that the documentation URL has been updated. (See 
“Passport 4400 Configurator Documentation URL Update” on page 39.)

• If you have installed the online documentation onto your PC's hard drive, you 
can access the documentation by opening the file named index.html, located 
in the directory where you installed the documentation.

• If you have installed the online documentation on a Web server, the URL you 
must use depends on where the documentation is installed on the server and 
how the Web site is configured and managed by the server's administrator or 
WebMaster. An example URL could be the following:

http://yugi/

Note: Some browsers require special setup. See “Browsers” on page 25. 
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(This URL assumes that the server's name is yugi, the documentation is in the 
root directory of the Web site established on the server, and that index.html is 
the default file that is served when the Web site is accessed.)

The server name “yugi” can be resolved by DNS; otherwise, use your server’s 
IP address. An example could be the following:

http://192.168.1.1

Navigating Online Documentation

The next and previous buttons in the document pages navigate you through the 
pages sequentially. If, for example, you have jumped (hyperlinked) to a new page 
and wish to return to your previous location, use the back button in the browser.

Back. Returns you to the
previous display. This is good
for jumping between
procedures or returning to the
previous screen after a
hyperlink jump.

PREV. This takes you to the
previous page in the document
regardless of how you got to
this page. Do not confuse this
PREV with Back.

NEXT. This takes you to the
next page in the document
regardless of how you got to
this page.
Getting Started with Passport 4400, Release 4.1
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There are four navigation tools to help you locate the information you require:

• the navigation menu in the left window.

• the table of contents, accessible from the TOC button on each page.

• the index, accessible from the index button on each page.

• the site map in the right window (accessed from the navigation tree). This is 
shown on page 23.

Navigation Tree

Site Map
See illustration
which follows

Click on a major
topic and sub
topic will display

TOC: Table of Contents
This will take you to a
comprehensive Table of
Contents (many pages).
It is not the preferred method.
Note that the Table of Contents
does not match either the
Navigation Tree or the Site Map.
It is merely a different method of

INDEX
This will take
you to the index

navigation.
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Site Map

The site map is an expanded version of the Navigation Tree. It permits you to 
browse through the documents to select the items you wish to view.

From any place in the documentation,
select Site Map from the Navigation Tree
to display the Site Map
Getting Started with Passport 4400, Release 4.1
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Within the documentation, there are two additional aids to help you: the end of 
topic sign and the end of procedure sign. When you see these aids, you have 
reached the end of the logical discussion. By pressing next you will be moved to 
new topic which may be completely unrelated.

This is the end of this topic. By pressing the
next button, you may or may not be at the
next logical topic.

This lets you know that this
procedure is now complete
209664-A
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Printing Online Documentation

In some cases, the HTML pages will not print properly. For print purposes, a copy 
of the documentation in PDF form is provided (config_ops_doc.pdf). Use the PDF 
file for printing requirements. It is recommended that you use a PostScript printer 
driver.

Browsers

The Configuring and Operation Passport 4400 Rel. 4 Software has been tested 
with the following browsers:

• Microsoft Internet Explorer 3, 4, and 5

• Netscape Communicator 4.5, 4.6, and 4.7

• Netscape Navigator 3 and 4

• Opera 3.60

• Mosaic 3

The Online Documentation has been tested with the following operating systems:

• Microsoft Windows 95

• Microsoft Windows NT 4, Workstation and Server

Best results are obtained when using a combination of Microsoft Internet Explorer 
4 and 5 on a Pentium PC running Microsoft Windows 95 or NT, having a display 
of 800 by 600 minimum resolution and capable of displaying 32,000 colors or 
more.
Getting Started with Passport 4400, Release 4.1
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Use the following table to get the optimum results from the browser you are using.

Browser How to Get Optimum Results

Microsoft Internet Explorer 4 or 5 Normal browser setup will provide optimum results.

Microsoft Internet Explorer 3 For best results, you should set the browser to 
disable using style sheets:
1. Select View -> Options and select the Advanced 

tab. 

2. Uncheck the box next to Use style sheets. 
3. Click on the Apply button. 

Also, you should choose the No Frames option from 
the online documentation startup page. The frameset 
for the online documentation may not be stable in 
Microsoft Internet Explorer 3. You may encounter 
pages displayed outside of the frameset.

Netscape Communicator 4.5,
 4.6, 4.7

As a minimum, you should make sure the browser 
window size is at least 800 by 600 pixels. If you must 
run the browser in a smaller window size or you 
encounter display problems, you should set the 
browser to Disable using styles sheets:
1. Select Edit -> Preferences and select Advanced. 

2. Uncheck the box next to Enable style sheets.
3. Click on the OK button. 

Netscape Navigator 4.08 As a minimum, you should make sure the browser 
window size is at least 800 by 600 pixels. If you must 
run the browser in a smaller window size or you 
encounter display problems, you should set the 
browser to Disable using styles sheets:

1. Select Edit -> Preferences and select Advanced. 
2. Uncheck the box next to Enable style sheets.
3. Click on the OK button. 

Netscape Navigator 3 Normal browser setup will provide optimum results. 
However, Navigator 3 does not support cascading 
style sheets, so the browser's default fonts are used. 
Navigator 3 uses serif fonts, black on a white 
background, as the default display.
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Opera 3.60 Normal browser setup will provide optimum results.

Mosaic 3 Normal browser setup will provide optimum results. 
However, Mosaic 3 does not support frames or 
cascading style sheets. The browser's default font 
set is used. Also, when you access the Configuring 
and Operation Passport 4400 Rel. 4 Software, 
206916-A with Mosaic 3, you will see a message that 
the browser does not support frames. Just click on 
the link provided to use the documentation without 
the frameset.

Browser How to Get Optimum Results
Getting Started with Passport 4400, Release 4.1
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Chapter 3
Hardware Setup

This chapter contains information for the required hardware needed to set up a 
workstation and a Passport 4460. These requirements will vary in accordance with 
the navigation tool you are using.

Workstation Requirements

Following is a list of workstation requirements needed for the Device and 
Network Management Tools.

If you are using.... You need....

Install Tool Windows-based PC (see chart on page 15)

Passport 4400 Configurator Any workstation that supports either Internet Explorer 
4.0 or Netscape Communicator 4.5 browser (see chart 
on page 15)

Command Line Interface (CLI) Dumb terminal or terminal emulation software (see 
chart on page 15)

Mass Deployment Reporting 
Tool (MDT)

Windows-based PC (see chart on page 15)

Optivity NMS 9.0 Any workstation (see chart on page 17)

Preside Multiservice Data 
Manager (PMDM)

Any workstation (see chart on page 17)

Open Management System for 
Passport (OMS-P)

Any workstation (see chart on page 17)
Getting Started with Passport 4400, Release 4.1
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Installing Passport 4460 Hardware

The next four steps must be executed before you can operate your Passport 4460 
unit. 

Installation information can be found in the Reference for Passport 4460 
Hardware, (205677-A). 

1 Install the Flash card, Chapter 4

2 Attach the interface cables, Chapter 6 (also refer to Reference for Passport 
4400 Cables, 205678-A)

3 Connect the workstation, Chapter 7

4 Power up your Passport 4460 unit, Chapter 1

In Chapter 1 of this manual, you were asked to evaluate the device management 
tools you are going to use. Refer to the table below and then go to the next 
procedure.

If you are using any of the network management tools, refer page 16 and page 17. 

Also note that the Configuring and Operation Passport 4400 Rel. 4 Software will 
be a good source of product and parameter information as you configure your 
unit.

If you are using.... Refer to....

Passport 4400 Configurator Chapter 4 of this manual

Command Line Interface (CLI) Chapters 5 and 6 of this manual

Install Tool Using Passport 4400 Install Tool Version 
4.1, 206906-B

Mass Deployment and Reporting Tool Using the Passport 4400 Mass Deployment 
and Reporting Tool, 209665-A
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Chapter 4
Configurator Procedure for Creating a Node 
Profile

A node profile is required for links established between the Passport 4460 unit and 
the Passport network. This chapter explains the node profile configuration 
procedure using Passport 4400 Configurator as your device management tool:

• “Accessing the Configurator Through a Web Browser” on page 32

• “Viewing Node Profile Information” on page 33

• “Defining a Unique DNA Prefix” on page 34

• “Defining a Node Name” on page 35

• “Defining a Node ID” on page 36

• “Defining a Customer ID” on page 37

• “Resetting the Unit” on page 37

• “Setting the DNA Numbering Plan” on page 38

• “Passport 4400 Configurator Documentation URL Update” on page 39

• “Setting the System Clock” on page 40

• “A confirmation message “Command Successful” indicates you have 
successfully updated the System Clock on your Passport 4460 unit.” on 
page 41

You need a properly configured workstation to use Configurator to access a 
Passport 4460. Refer to Using Passport 4400 Install Tool Version 4.1, 206906-A, 
Chapter 5, Configuring the Workstation, for a detailed description of the 
requirements and procedures for setting up the workstation. 

Note: The null modem driver is required for a direct connection. The 
null modem is not required for the ethernet connection.
Getting Started with Passport 4400, Release 4.1
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Accessing the Configurator Through a Web Browser

To access Configurator:

1 Start your web browser and enter the IP address for your Configurator web 
pages (http://192.168.200.200). The Username and Password dialog box 
opens. 

2 Enter the default User Name (passport) and Password (private).

3 Click OK. The Configurator Main window opens:

Note: When first accessing Configurator through the Netscape web 
browser on a Sun Sparc workstation, you may encounter the following 
error message: "URL could not be retrieved." Try deleting the Netscape 
directory in your home directory. This will force Netscape to re-initialize 
itself. Before deleting the directory, remember to copy all of your prior 
settings and bookmarks into another directory.
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The left side of the window displays the menu and the right side displays the 
Passport 4400 unit’s main page. You are now logged into the Configurator 
web pages.

Viewing Node Profile Information

To view your current node profile, use the following steps:

1 Click on Configure.

2 Click on System.

3 Click on Identity. The System Identity window opens:
Getting Started with Passport 4400, Release 4.1
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Defining a Unique DNA Prefix

To Define a unique DNA prefix:

1 Click on Configure.

2 Click on System.

3 Click on Identity. The System Identity window opens:

4 Enter the DNA prefix string for this Passport 4460 unit in the Device Network 
Address field.

Continue with “Defining a Node Name” on page 35.

Note: Be careful not to delete the DNA numbering plan when 
modifying your device network address. If you’d like to change your 
DNA numbering plan go to “Overriding the DNA Numbering Plan” on 
page 39.
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Defining a Node Name

To define a node name, go to the System Identify window in the Node Name field 
and enter the node name for this Passport 4460 (for example: pubsA).

If you don’t want to modify any more parameters in this window, click Save. A 
“Command Successful” appears. If you are done, you must reset the system 
before the new configuration takes effect. Go to “Resetting the Unit” on page 37.

If your Passport 4460 is part of a larger Passport network, you may want to define 
a Node ID and Customer ID for network management purposes. Continue with 
these steps:

• “Defining a Node ID” on page 36

• “Defining a Customer ID” on page 37
Getting Started with Passport 4400, Release 4.1
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Defining a Node ID

To define a Node ID, enter the node ID in the Node ID field. Enter an integer 
between 1 and 65535 (for example, 23). If your network uses node IDs to identify 
Passport 4400 units, be sure to assign each unit a unique node ID.

If you don’t want to modify any more parameters in this window, click Save. A 
“Command Successful” appears. If you are done, you must reset the system 
before the new configuration takes effect. Go to “Resetting the Unit” on page 37, 
or continue with “Defining a Customer ID” on page 37.
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Defining a Customer ID

To Define a Customer ID:

1 Enter the customer ID in the Customer ID field. Enter an integer between 1 
and 65535 (for example, 9265).

2 After you have completed modifying your parameters, click Save. A 
Command Successful message appears.

3 You must reset the system before the new configuration takes effect. 
Continue below.

Resetting the Unit

1 Click on Administration.

2 Click on System Reset. The System Reset window opens:

In the Reset Type field, use the pull down menu to select Configuration. Click 
Reset. A unit reset confirmation message is displayed.
Getting Started with Passport 4400, Release 4.1
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3 Click OK. A display shows you the reset progress:

Setting the DNA Numbering Plan

To set the DNA numbering plan using Configurator, use the following steps:

1 Click on Configure.

2 Click on System.

3 Click on Identity. The System Identity window opens:

The DNA numbering plan is contained in the first part of the Device Network 
Address.

4 If you’d like to change the DNA numbering plan to e164 (if this is required by 
your Passport 6400), delete “[x121]”, and type “[e164]” before the DNA 
prefix string. You will use x121 in Passport 4400 only networks.

Note: Make sure that you don’t delete the DNA prefix string, which 
appears after the DNA numbering plan.
209664-A
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5 After you have completed modifying the DNA numbering plan, click Save. A 
“Command Successful” message appears. This indicates you have 
successfully updated the DNA numbering plan on your Passport 4460 unit.

Overriding the DNA Numbering Plan

In addition to changing the DNA numbering plan, it is possible to override the 
current numbering plan by entering the other numbering plan type within square 
brackets [ ] in front of the DNA number.

To modify your DNA numbering plan, go to “Setting the DNA Numbering Plan” 
on page 38.

Passport 4400 Configurator Documentation URL Update

When you have installed the online documentation on a web site, you must set the 
documentation URL for the Passport 4400 Configurator in order to be able to 
access the online documentation (Configuring and Operation Passport 4400 Rel. 
4 Software, 206916-A) from within the Passport 4400 Configurator.

This URL can only be changed through the Passport 4400 Configurator web 
pages.

1 Click on Administration.

Note: For more information concerning using a Passport 6400 in your 
Passport network, refer to Reference for Passport 4400 and 6400 
Interworking, 209372-A
Getting Started with Passport 4400, Release 4.1
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2 Click on Document URL. The Documentation URL window opens:

The URL in the window is where the online documentation is located, at the 
Nortel Internet site, on your PC, workstation, server, or on the CD at your PC.

3 If you have downloaded the documentation elsewhere, enter the URL in the 
Documentation Server URL field, and click Save. A “Command Successful” 
appears.

Setting the System Clock

The Passport 4460 unit has an internal battery-backed calendar and clock. Upon 
receiving a Passport 4460 unit from the factory, enter the current date and time:

To set the System Clock on your Passport 4460 unit, use the following steps:

1 From the table of contents menu, click on Administration.
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2 Click on Date & Time. The Date and Time window opens:

3 Update any field you want to set, then click Save.

4 A confirmation message “Command Successful” indicates you have 
successfully updated the System Clock on your Passport 4460 unit.

At this point you have completed the minimum requirements for getting started 
using Configurator. Your unit should now be able to communicate on the network. 
You will need to proceed with the configuration. Refer to Configuring and 
Operation Passport 4400 Rel. 4 Software, 206916-A, (online documentation) to 
continue.
Getting Started with Passport 4400, Release 4.1



42 Chapter 4 Configurator Procedure for Creating a Node Profile

 

209664-A



43

 

Chapter 5
Accessing the CLI and Basic Configuration

This chapter explains the basic configuration procedure using the Command Line 
Interface (CLI) as your device management tool. Proceed with the following: 

• “Using a Terminal” on page 43

• “Communication Parameter Set-Up Requirements” on page 44

• “Logging into the CLI Using the Terminal Emulation Program” on page 46

• “Assigning the IP Address” on page 47

The Passport 4460 is shipped from the factory with a pre-configured IP address 
(192.168.200.200). After you have accessed your Passport 4460 using this IP 
address, you should assign an IP address specific to your Passport 4460 network 
through the CLI. 

Using a Terminal

Before you can access the CLI in your Passport 4460 unit, you must have 
followed the physical installation procedures found in Reference for Passport 
4460 Hardware, 205677-A, and powered-up the unit.

Note: This procedure can be done using any terminal emulation 
program. The sample procedure below uses Windows 95’s 
HyperTerminal program.
Getting Started with Passport 4400, Release 4.1
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Communication Parameter Set-Up Requirements

1 From the windows start menu, choose Program > Accessories > 
HyperTerminal. You will see the HyperTerminal window.

2 Choose HyperTerminal. You will see the Connection Description window:
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3 Enter a name to identify your Passport 4460 connection and Click OK. You 
will see the Phone Number window:

4 Select the communication port to which you connected the Management Port 
cable. Click OK. You will see the Port Settings window:
Getting Started with Passport 4400, Release 4.1
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5 Set the following communication parameters for the terminal:

6 Click OK twice. You have now completed the HyperTerminal setup. Continue 
on to Logging into the CLI Using the Terminal Emulation Program below.

Logging into the CLI Using the Terminal Emulation 
Program

1 Access the terminal emulation program you set up for this connection. A 
blank window opens.

2 Press [Enter] until you see a Login prompt.

3 At the Login prompt, type cli and press [Enter]. A Password prompt is 
displayed.

4 Press [Enter]. You are now logged into the CLI and ready to initially 
configure and assign an IP address to your Passport 4460 unit.

Continue on to Assigning the IP Address.

Data Rate 9600 bps

Data Bits 8

Stop Bits 1

Parity None

Flow control Xon/Xoff

Note: If you are unable to connect to the Passport 4460, try selecting 
Hardware in the flow control field.
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Assigning the IP Address

Passport 4460 units are shipped with a default IP address of 192.168.200.200. You 
need to change the IP address to match the configuration of your network.

To display the Passport 4460’s IfIndexes, type in the following command:

CLI> show ip address operational table

The following display is shown:

IfIndex : 1
IPAddress : 199.30.20.77
Mtu : 1500
DataLinkType : ether
KeepAlive : on
ForwardBcast : off
IPNumber : numbered
RouteProtocolType : disable

IfIndex : 2
IPAddress : 199.168.25.24
Mtu : 1500
DataLinkType : fr
KeepAlive : off
ForwardBcast : off
IPNumber : numbered
RouteProtocolType : rip

IfIndex : 32
IPAddress : 199.168.200.200
Mtu : 1500

Note: The name for the base module is always base; Expansion modules 
are named exp1, exp2; the PCMCIA module is named pcmciaExp.
Getting Started with Passport 4400, Release 4.1
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5 Use the following CLI command to assign the IP address:

CLI> add ip address entry

Example:

CLI> add ip address entry 3 192.168.22.22 255.255.0.0 192.168.255.255

6 Save the configuration and reset the unit.

CLI> save configuration update

CLI> reset system current reset

Parameter Range of Values Required Actions

<IfIndex> INTEGER (1..255) Enter the IfIndex of the Interface 
displayed in Step .

<IPAddress> IPAddress Enter the IP address you want to 
assign the Passport 4460.

<NetMask> Sub-NetMask 
(255.255.255.0, 
255.255.0.0, or 
255.0.0.0)

Enter the subnet mask. The bits of the 
subnet mask are set to 1 if the 
Passport 4460 should treat the 
corresponding bit in the IP address as 
part of the IP network prefix.

<BcastAddress> IPAddress The IP address used for broadcasting.
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Chapter 6
CLI Procedure for Creating a Node Profile

A node profile is required for links established between the Passport 4460 and the 
Passport network. 

This chapter explains the node profile procedure using CLI as your device 
management tool:

• “Viewing Node Profile Information” on page 50

• “Defining a Unique DNA Prefix” on page 51

• “Defining a Node Name” on page 52

• “Defining Node ID” on page 53

• “Defining Customer ID” on page 53

• “Confirming the New Configuration” on page 54

• “Saving the Current Configuration and Resetting the Unit” on page 54

• “Setting the System Clock” on page 55
Getting Started with Passport 4400, Release 4.1
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Viewing Node Profile Information

To view your current node profile, use the following CLI commands:

CLI> show msm profile

A table similar to the following is displayed:

CLI> show system administration

A table similar to the following appears:

NodeID 1 (operational)

23 (configured)

Customer ID 0 (operational)
9265 (configured)

DNAPrefix “[x121]” (operational)
“[x121]123456789012” (configured)

ConfigVersion :"Passport_4430/50_Appl_Rel4.0.0_Rev”

ObjectID “1.3.6.1.4.1.335.1.4”

UpTime 00Years 001Days 23:49:26

Contact “ “

NodeName “PUBSA”

Location “ “

Services 4
209664-A
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Defining a Unique DNA Prefix

To define a unique DNA prefix, use the following CLI command:

CLI> define msm profile dnaPrefix

Example:

CLI> define msm profile dnaPrefix “626555134201”

Continue with “Defining a Node Name” on page 52.

Parameter Range of Values Required Action

<DNAPrefix> “String” (1..31) Enter the DNA prefix string for this 
Passport 4460 unit. The string must be 
enclosed within quotation marks.

Note: When entering the DNA prefix, it is not necessary to enter the type 
of numbering plan. If you want to override the default numbering plan, 
see Configuring and Operating Passport 4400 Rel. 4 Software, 
206916-A.
Getting Started with Passport 4400, Release 4.1
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Defining a Node Name

To define a node name, use the following CLI command:

CLI> set system administration NodeName

Example:

CLI> set system administration NodeName “456543”

If you don’t want to modify any more parameters in this window, you must save 
and reset the system before the new configuration takes effect. Go to “Saving the 
Current Configuration and Resetting the Unit” on page 54.

If your Passport 4460 is part of a larger Passport network, you may want to define 
a Node ID and Customer ID for network management purposes. Continue with 
these steps:

• “Defining Node ID” on page 53

• “Defining Customer ID” on page 53

Parameter Range of Values Required Action

<NodeName> “String” (1..50) Enter the node name to be assigned to 
this Passport 4460 unit. The string must 
be enclosed within quotation marks.
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Defining Node ID 

To define a node ID, use the following CLI command:

CLI> define msm profile nodeID

Example:

CLI> define msm profile nodeID 23

If you don’t want to modify any more parameters in this window, go to “Saving 
the Current Configuration and Resetting the Unit” on page 54, or continue with 
“Defining Customer ID” on page 53.

Defining Customer ID

To define a customer ID, use the following CLI command:

CLI> define msm profile customerID

Parameter Range of Value Required Action

<NodeID> INTEGER (1..65535) Enter an integer between 1 and 
65535. If your network uses node 
IDs to identify Passport 4460 units, 
be sure to assign each unit a unique 
node ID.

Note: The element msm signifies the MPANL signal mechanism. The 
customer ID is expressed as an integer between 0 and 65535. The terms 
MPANL and PANL both refer to the same protocol and may be used 
interchangeably.

Parameter Range of Value Required Action

<CustomerID> INTEGER (0..65535) Enter an integer between 1 and 
65535.
Getting Started with Passport 4400, Release 4.1
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Example:

CLI> define msm profile customerID 9265

Confirming the New Configuration

To confirm your new configuration, use the following CLI command line:

CLI> show msm profile

A table similar to the following is displayed:

Any changes that have been made to the node ID, customer ID, and DNA prefix 
will show up as configured in the display above. 

Saving the Current Configuration and Resetting the Unit

To save and reset the unit, use the following CLI command line:

CLI> save configuration update

CLI> reset system current reset

After saving the current configuration and resetting the Passport 4460 unit, use the 
CLI command, show msm profile to view your changes. The NodeID, 
Customer ID, and DNAPrefix parameters should display as operational and 
configured.

NodeID 1 (operational)

23 (configured)

Customer ID 0 (operational)
9265 (configured)

DNAPrefix “[x121]” (operational)
“[x121]123456789012” (configured)
209664-A



Chapter 6 CLI Procedure for Creating a Node Profile 55

 

Setting the System Clock

The Passport 4460 unit has an internal battery-backed calendar and clock. Upon 
receiving a Passport 4460 unit from the factory, enter the current date and time:

CLI> set system timeOfDay

The following list is displayed:

date
day
hour
minute
month
second
year

Enter each element you wish to set.

Example:

CLI> set system timeOfDay date

. 

Example:

CLI> set system timeOfDay date 9

To view the settings, use the show system time of Day.

Example:

CLI> show system timeOfDay

Parameter Range of Value Required Action

<Date> INTEGER (1..31) Enter an integer between 1 and 31. 
If it is a single digit month you must 
add a zero in front of it. The year 
must include 4 digits.
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Information similar to the following is displayed:

04/09/2000 18:30:15 Monday
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Appendix A
IfIndexes and Interface Identification

The following topics are discussed in this chapter.

• “IfIndex Overview” on page 57

• “Hard-Coded IfIndexes” on page 58

• “Reserved IfIndexes and Ranges” on page 58

• “IfIndex Table Display Definitions” on page 62

IfIndex Overview

Each physical and virtual interface on the Passport 4460 is assigned an IfIndex, a 
unique identifier that allows SNMP to read and write status information. These 
IfIndexes are used to establish logical links between interfaces and higher-level 
applications and protocol stacks.

The Passport 4460 can support up to 255 IfIndexes. Some of these are hard-coded 
and cannot be changed; others are automatically reserved by the Passport 4460 
operating system when the unit is powered on. 

For more information on IfIndexes, proceed to the the following:

• “Hard-Coded IfIndexes” on page 58

• “Reserved IfIndexes and Ranges” on page 58

• “IfIndex Table Display Description” on page 60
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Hard-Coded IfIndexes

The following IfIndex numbers are hard-coded, representing the interfaces that 
are initially present in the Passport 4460.

Reserved IfIndexes and Ranges

The Passport 4460 also reserves IfIndexes for available ports on the base module 
and expansion data modules. By reserving these IfIndexes, the Passport 4460 
guarantees that a specific port always uses the same IfIndex. For instance, Port 1 
always uses IfIndex 150 to refer to the physical interface.

The following table lists IfIndexes that are reserved for use by the ports located on 
the base module.

There are three reserved IfIndexes associated with each port. For Port 1, IfIndex 
150 refers to the physical port interface, 151 refers to the connector interface, and 
152 refers to the frame relay service.

IfIndex Description

1 Logical Ethernet interface for routed LAN traffic

2 Virtual port for WAN traffic

3 Logical Ethernet interface for bridged LAN traffic

4 Virtual port for network management traffic

Port Number IfIndex - Physical Port IfIndex - Connector IfIndex - Service

1 150 151 152

2 153 154 155

3 156 157 158
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IfIndex Ranges

Although the following ranges of IfIndexes may not currently be assigned, they 
are reserved and you should assign them only to the indicated interface type:

• 1-4: Ethernet port assignments

• 5-32: Additional virtual ports

• 33-148: Voice assignments

• 149-206: WAN port and Expansion port assignments

Safe IfIndex Ranges

You can assign available IfIndexes between 207 and 255 when creating, for 
example, a frame relay tunnel PVC, and not worry about the assignment being 
overwritten when new modules are defined on the Passport 4460 unit. Go to,

• “IfIndex Overview” on page 57

• “Hard-Coded IfIndexes” on page 58

• “IfIndex Table Display Description” on page 60

Note: If the Passport 4460 unit is set to factory defaults, the default IfIn-
dex assignment for the primary netlink is 149 or 147 (for units with only 
one Ethernet Base Module port available). The Passport 4400 Install Tool 
automatically deletes IfIndex assignments 149 and 147. Install Tool may 
be used at any time for installation and/or configuration of the Passport 
4460 unit. You should make sure the primary netlink is assigned to an 
IfIndex of 207 or higher, and avoid assigning anything to either IfIndex 
149 or 147.
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IfIndex Table Display Description

You can display a list of all IfIndexes currently assigned to interfaces on the 
Passport 4460. Go to:

• “Configurator Procedure for Displaying the IfIndex Table” on page 60

• “CLI Procedure for Displaying the IfIndex Table” on page 61

• “IfIndex Overview” on page 57

• “Hard-Coded IfIndexes” on page 58

• “Reserved IfIndexes and Ranges” on page 58

Configurator Procedure for Displaying the IfIndex Table

To display IfIndexes through Configurator:

1 Click on Status/Statistics.

2 Click on All Interfaces. You will see the Interface Status/Statistics window. 
Below is a partial display of the IfIndex Table using Configurator.

3 See “IfIndex Table Display Definitions” on page 62 for a description of the 
above parameters.
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CLI Procedure for Displaying the IfIndex Table 

The following sample display is taken from a Passport 4460 with two expansion 
modules installed, an ISDN BRI S/T Voice module and a T1 Voice module. Below 
is a partial display of the IfIndex Table using CLI.

CLI> show system IfIndex Operational

IfIndex IfExtType PPA Slot

1 ethernetCsmacd 0 base

2 propVirtual 0 base

3 other 0 base

4 propVirtual 1 base

5 isdns 1 exp1

6 ds0 1 exp1

7 ds1 0 exp2

8 other 0 exp2

9 other 0 exp2

10 other 0 exp2

11 other 0 exp2

12 other 0 exp2

13 other 0 exp2

14 other 0 exp2

15 other 0 exp2

16 other 0 exp2
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IfIndex Table Display Definitions

Interface Extension Type

The interface extension type, shown as IfExtType in the display above, describes 
the port, protocol, service, or other interface identified by the IfIndex. The 
following table describes some of the common interface extension types seen on 
the Passport 4460.

PPA Number

The Point of Physical Attachment (PPA) is not a literal physical point of 
attachment, but is an internal identifier for the Passport 4460 code. Each PPA can 
have one or more IfIndexes associated with it, but the PPA numbers are unique 
only within the module; they are not unique across all devices or slots.

ethernetCsmacd The Ethernet port (10BASE-T or AUI) on the base module. This 
interface is always assigned IfIndex 1.

propVirtual A virtual port on the Passport 4460. Virtual ports are used to direct 
traffic across a WAN link. By default, there are two virtual ports, 
assigned IfIndexes 2 and 4. For more information on virtual ports, 
see the Online Documentation, LAN Services.

propMultiplexor A physical port on the Passport 4460. There are three physical 
ports on the base module.

frameRelay A frame relay protocol implemented on a physical port. 
frameRelay refers to the switching protocol used for PANL and 
RFC1490 netlinks.

frameRelayService A frame relay protocol implemented on a physical port. 
frameRelayService refers to Frame Relay DCE service.

v35 The connector type for a physical port. V.35 is one of several 
connector types supported on Passport 4460 physical ports. For 
more information, refer to Reference for the Passport 4400 Cables, 
205678-A or Reference for the Passport 4460 Hardware, 
205677-A.

other The protocol or service for this IfIndex is undefined or unknown to 
the Passport 4460.
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For physical interfaces, the PPA number corresponds to the physical port number 
on the module. For logical or virtual interfaces, the number corresponds to a 
logical port or interface and is dependent on the interface module type. If a device 
does not support PPAs, the value -1 indicates that the field is not used as an 
identifier.

Slot Name

The physical interface module is the name that the Passport 4460 uses to identify a 
module interface. The base module is always base, and expansion modules are 
named exp1 and exp2.The Serial Daughter Boards (SDBs) are considered 
expansions to the base module itself, and are referred to as Port 2 and Port 3 of the 
base module.

Channel Number

The channel number along with the slot and PPA number, uniquely identifies an 
interface within a device type. However, the channel number itself is not unique 
across all device types.

To display the channel number of an interface, along with additional interface 
information, use the following CLI command:

CLI> show system interfaceExtension operational table

See “Configurator Procedure for Displaying the IfIndex Table” on page 60 for the 
Configurator steps for displaying IfIndex parameters.

For interfaces describing serial data connections (data ports), the channel number 
refers to the physical data channel. For interfaces describing voice channels, the 
channel number refers to the corresponding voice channel number. For interface 
types that do not use a channel number, the value of -1 is used.
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Appendix B
Installing System Software from the CD-ROM

For software installation for Install Tool, refer to Using Passport 4400 Install Tool 
Version 4.1, 206906-B.

For software installation for the Mass Deployment and Reporting Tool, refer to 
Using the Passport 4400 Mass Deployment and Reporting Tool, 209665-A

For software installation for the system software from the CD-ROM, follow these 
steps:

1 Place the CD into the drive

2 From the D: drive (where D: is your CD-ROM drive) icon on your screen 
double click on the CD icon

3 Double click on software

Application Code

The application code is installed on your Passport 4460 unit as you download the 
application software. 

The Passport 4460 application software is a single file (pr41xxxx.bld) supplied in 
a “bld” format consisting of the following executable images:

• Ethernet Base Module code (PR4_1_0.CMP and IO4_1_0.CMP)

• DSP code for voice (dspc54xx.voc)

• Code for the Passport 4400 Configurator (HTML.CMP)
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Downloading Application Software

The following procedures are contained in this section:

• “Configurator Procedure for Downloading Application Software” on page 66

• “CLI Procedure for Downloading Application Software” on page 69

Configurator Procedure for Downloading Application 
Software

The following tasks must be completed:

• “Enter the IP address of the TFTP Host Workstation and Download the Code 
Files” on page 66

• “Commit the Application Code Bank” on page 67

• “Save the Current Configuration and Reset the Unit” on page 68

Enter the IP address of the TFTP Host Workstation and 
Download the Code Files

1 Under Administration, select TFTP Operation. You will see the TFTP 
Operation window:

2 In the Server IP Address field, enter the IP address of the TFTP host 
workstation where the download code files reside.

3 Click Save. A “Command Successful” appears.
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4 At the top of the window, click on Code Download. You will see the TFTP 
Code Download window:

5 In the Filename field, enter the filename and path (if applicable).

6 Click Download (from Server). A Command Successful message appears. 

7 To verify the download status, click on TFTP Status at the top of the window. 
You will see the TFTP Status window:

This window displays the progress of the download process.

8 Take note of the Transfer Mode status (To_Bank_1 or To_Bank_2). You will 
need this value to continue with the next procedure.

9 When the Last Transfer Status shows Download Successful, your download is 
complete.

Commit the Application Code Bank

1 Select Administration and Code Bank.
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You will see the Code Bank window:

2 Next to Commit Bank, use the pull down menu and select the code bank that 
was displayed in step 8 of the previous procedure.

The opposite bank is now uncommitted, and a subsequent application code 
download will write to that bank.

3 Click Save. A “Command Successful” appears.

Save the Current Configuration and Reset the Unit

1 Under Administration select System Reset. You will see the System Reset 
window.

2 In the Reset Type field, use the pull down menu to select Configuration. Click 
Reset. A unit reset confirmation message is displayed:

3 Click OK. A display shows you the reset progress
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CLI Procedure for Downloading Application Software

1 Load the Passport 4460 Release 4.1 software onto your TFTP server (boot and 
application code as required).

2 Access the CLI (it may be necessary to do this through a Telnet session).

3 Download the boot code (if necessary). Otherwise, skip this step.

Example:

Download base image specific 192.168.15.30 “bt41xxxx.bld”. This will 
download the file bt41xxxx.bld from the TFTP host with the IP address 
192.168.15.30 (where x’s represent the current version/filename).

4 Download the Release 4.1 application code onto the Passport 4460 unit using 
TFTP.

a Commit the application code bank that will be write-protected during the 
download

Example:

CLI> set system firmware commitcodebank bank 1

This will write-protect application code bank 1. The application code will 
be downloaded into bank 2.

b Download the application code,

Example:

CLI> download base image specific 192.168.15.30 “pr41xxxx.bld”

This command downloads the file pr41xxxx.bld from the TFTP host 
whose IP address is 192.168.15.30 (where x’s represent the current 
version/filename).

5 Commit the new application software to the write-protected bank.

Example:

CLI> set system firmware commitcodebank bank2
Getting Started with Passport 4400, Release 4.1



70 Appendix B Installing System Software from the CD-ROM

 

6 Restart the Passport 4460 unit

Example:

CLI> reset system current reset

7 Log in to the CLI again. It may be necessary to establish another Telnet 
session.

8 If you are upgrading your software, be sure to extract the latest MIBs and 
install the new ones.
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